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1.	Общая информация
1.1.	 Передаваемые файлы в типографию «Принт-люкс» подготовлены с учетом данных техни-

ческих требований и не требуют правок. Предупреждаем, что файлы, не соответствующие 
техническим требованиям, могут привести к ошибкам в процессе печати и послепечат-
ной отделки. Данные технические требования не являются общими правилами, т. к. не-
возможно учитывать все правила создания макетов для офсетной печати в рамках данного 
документа.

1.2.	 Отдел предпечатной подготовки типографии «Принт-люкс» проводит проверку файлов 
на соответствие данным техническим требованиям, но не гарантирует обнаружения всех 
ошибок. О всех обнаруженных ошибках сообщается заказчику по телефону или электрон-
ной почте и предлагается решение по их исправлению. 

1.3.	 При несоответствии макета с данными техническими требованиями типография «Принт-
люкс» оставляет за собой право не принимать макет в производство.

1.4.	 Отдел допечатной подготовки типографии «Принт-люкс» при согласовании дополнитель-
ной стоимости с заказчиком производит работу по исправлению обнаруженных ошибок, 
возможных к исправлению в соответствии с данными техническими требованиями. 

1.5.	 Исправленные макеты отделом допечатной подготовки «Принт-люкс» утверждаются со-
гласно пунктам 2.4, 2.5 данных технических требований.

2.	Порядок приема файлов в производство
2.1.	 Файлы могут быть переданы в типографию следующими способами:

•	 на CD- и DVD-дисках, с распечаткой макета, подписанной заказчиком согласно пункту 
2.4 данных технических требований;

•	 на внешних носителях USB, FireWare (при наличии шнуров и драйверов к ним), с рас-
печаткой макета, подписанной заказчиком согласно пункту 2.4 данных технических 
требований;

•	 через Интернет – e-mail, ftp. После скачивания макет утверждается у заказчика соглас-
но пунктам 2.4 или 2.5 данных технических требований.

2.2.	 Обязательным условием передачи материалов в типографию «Принт-люкс» является на-
личие сведений о предоставляемых файлах. К сведениям относятся: название файла, го-
товый (обрезной) формат изделия, красочность, послепечатная отделка и т. д. Заказчик 
обязательно предоставляет для всех файлов макета просмотровые (preview) JPEG-файлы 
(RGB, 150dpi, Medium Quality, масштаб 1:1).

2.3.	 Заказ считается принятым в производство после прохождения визуальной и технологиче-
ской проверки файлов согласно данным техническим требованиям утвержденный соглас-
но пунктам 2.4 или 2.5.

2.4.	 Утверждение заказчиком распечатанного макета: Заказчик на каждой распечатке ставит 
подпись, дату подписи, пишет текст «Утверждаю в печать». Также это утверждение может 
выполнить менеджер типографии «Принт-люкс» с согласия Заказчика, прописанного в до-
говоре  «Принт-люкс» с Заказчикам в определенном пункте.

2.5.	 Утверждение Заказчиком макета по e-mail: Заказчик получает на свою электронную по-
чту макет в виде просмотровых файлов (JPEG или PDF) для утверждения, после просмо-
тра Заказчиком и утверждения полученных файлов (JPEG или PDF) отправляет ответное 
электронное письмо с утвержденным вложением просмотровых файлов макета (JPEG или 
PDF) с формулировкой «Утверждаю макет в печать».
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3.	Форматы файлов, принимаемых в производство
•	 композитный PDF (версия 1.3);
•	 EPS;
•	 изображения в форматах TIFF, JPEG, PSD (Grayscale/CMYK/ Multichannel, 8 бит);
•	 Adobe InDesign версии CS, CS2, CS3, CS4  (для Windows), 
                                      версии CS, CS2 (для Mac OS X);
•	 Adobe Illustrator версии CS, CS2, CS3, CS4 (для Windows),
                                       версии CS, CS2 (для Mac OS X);
•	 QuarkXPress версии 5.x, 6.x, 7.x (для Windows, Mac OS X);
•	 CorelDRAW версии 9, 10, 11, 12, X3 (только для Windows).

3.1.	 Если в этом списке не оказалось программы, используемой вами при подготовке макета 
заказа, то запишите ваши материалы в PDF-файл в соответствии с нижеприведенными ре-
комендациями для файлов макета. Корректно подготовленный PDF-файл – это наиболее 
предпочтительный формат файлов для передачи макета в типографию.

3.2.	 Файлы макетов рекомендуется передавать в виде архивов RAR, ZIP.
3.3.	 Для макетов, созданных в Mac OS X, – принимаются файлы только в архивах SIT, SITX. 
3.4.	 Не принимаются архивы в виде самораспаковывающихся EXE-файлов.
3.5.	 Не принимаются цветоделенные (separations) PS- и PDF-файлы.

4.	Общие требования к макетам
Название файла не должно превышать 30 знаков. Допускается использование только латинских 
букв A-Z, цифр 0-9, пробелов и символа нижнего подчеркивания «_». Недопустимы русские сим-
волы и знаки пунктуации. Название файла должно соответствовать его содержанию и быть интуи-
тивно понятным, например: blok_p01-16.qxp (блок, страницы с 1 по 16), face.eps и back.eps (лицо 
и оборот изделия), cover4-1.pdf (обложка в развороте, 4 и 1 полосы). 
4.1.	 При предоставлении макета в виде верстки в комплекте с файлами макета должны прила-

гаться файлы шрифтов для всех использованных шрифтовых начертаний. 
4.2.	 Размер полосы в файле макета должен быть равен обрезному формату изделия.
4.3.	 Если ваш файл содержит НЕСКОЛЬКО ВИДОВ ПРОДУКЦИИ, разместите КАЖДЫЙ 

ВИД продукции В ОТДЕЛЬНОМ ФАЙЛЕ. 
4.4.	 Макеты с количеством полос более 8 должны быть выполнены в программах, поддержи-

вающих многополосные документы. Недопустимо предоставлять для таких публикаций 
отдельные файлы на каждую полосу. Многополосные публикации в программах верстки 
допустимо разделять максимум на 8 файлов.

4.5.	 Полосы в файле должны следовать в том же порядке, что и в готовом издании. Если в из-
дании планируются пустые полосы, то и в файлах они должны присутствовать.

4.6.	 Все файлы верстки, содержащие полосы одного макета, должны иметь одинаковую ориен-
тацию – вертикальную или горизонтальную.

4.7.	 Не выполняйте спуск полос, а для многополосных макетов не верстайте полосы в чита-
тельских или печатных разворотах, в многостраничном документе – одна полоса в файле 
должна соответствовать одной полосе в издании. 

4.8.	 Все значимые элементы макета должны быть расположены не ближе 3-5 мм от обрезного 
формата, а элементы, расположенные на вылет, должны выходить за обрезной формат на 
3-5 мм. Вылеты (bleed) должны быть равными со всех четырех сторон.

4.9.	 При верстке разворотных полос в макете нежелательно использовать значимые элементы 
дизайна, совмещаемые в корешке или в торцах (на вылет) – линии, схемы, таблицы, пор-
треты, мелкие цветные плашки и т. д. Ответственность за точность позиционирования и 
совмещения подобных объектов в макете несет Заказчик. Для контроля совмещения эле-
ментов дизайна в корешке рекомендуется при верстке использовать «Facing pages».
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4.10.	 В файлах допустимо присутствие только цветовых моделей Grayscale, CMYK и только тех 
смесевых красок PANTONE, что действительно будут использоваться при печати заказа.

4.11.	 В файлах смесевые краски PANTONE должны быть определены как краски «Spot».
4.12.	 Объекты в цветовой модели Grayscale печатаются одной черной краской (Black).
4.13.	 Не допускается использование в макете цвета CMYK = 100:100:100:100 и «Registration», 

этот цвет предназначен только для печати технологических приводных крестов.
4.14.	 При печати макета CMYK+PANTONE или несколькими PANTONE с пересекающимися 

красками Заказчику рекомендуется указать желаемый порядок наложения красок в от-
дельном пункте договора «Принт-люкс».

4.15.	 Все иллюстрации в макете должны быть повернуты, обрезаны в программе обработки 
изображений Adobe Photoshop и заверстаны в полосу макета в масштабе 1:1 (100 %).

4.16.	 Допустимая величина графического разрешения для точечных изображений (Bitmap) – от 
600 dpi до 1200 dpi, для полутоновых изображений – от 200 dpi до 400 dpi. 

4.17.	 При использовании изображений с низким разрешением – менее 600 dpi для точечных и 
менее 200 dpi для полутоновых – в них может стать заметной пиксельная структура (воз-
можно появление «зубчатых линий») и появление муара при печати заказа. 

4.18.	 При наличии в макете полутоновых изображений с чрезмерно высоким разрешением спе-
циалисты отдела предпечатной подготовки типографии могут понизить разрешение до 
300 dpi с целью повышения скорости обработки файлов.

4.19.	 Внедренные цветовые ICC-профили в макете не учитываются, при печати заказа исполь-
зуются непосредственные процентные значения красок в файлах макета.

4.20.	 Максимальная суммарная красочность (total ink limit) TIL = % Сyan + % Magenta + % 
Yellow + % Black, для печати на мелованных бумагах – 320 %, на немелованных – 280 %.

4.21.	 Самые светлые участки градиентных заливок и иллюстраций должны содержать не менее 
2-3 % цвета по каждой из красок, например, 2 % Сyan + 2 % Magenta + 2 % Yellow. 

4.22.	 Черный текст следует печатать в одну черную краску 100 % Black, а крупные заголовки и 
большие черные области (плашки) рекомендуется печатать насыщенным составным чер-
ным цветом Rich Black = 50 % Сyan + 40 % Magenta + 40 % Yellow + 100 % Black.

4.23.	 Линии толщиной менее 0,5 мм (1,5 pt) следует печатать в одну краску и желательно 100 % 
краски. Линии толщиной менее 0,03 мм не пропечатываются.

4.24.	 Рекомендуется не использовать выворотку по сложному цвету тоньше 0,5 мм (1,5 pt).
4.25.	 Для мелкого цветного текста размером 5-8 pt или текста, печатаемого вывороткой, ре-

комендуется не использовать шрифты с засечками и тонкими элементами. Желательно 
максимально возможно увеличивать размер шрифта.

4.26.	 Во всех макетах, печатаемых только триадными красками (CMYK), по умолчанию объ-
ектам цвета 100 % Black устанавливается значение Overprint Black On, с объектов иных 
цветов параметр Overprint может быть изменен на значение Overprint Off (knockout). 

4.27.	 Результат, полученный при печати заказа, без предварительного согласования Overprint 
не может служить основанием для претензий. Значение Overprint может изменяться в 
зависимости от макета и особенностей производственного процесса. О выбранном заказ-
чиком наложении цвета или его вычитании Заказчик прописывает отдельным пунктом в 
договоре «Принт-люкс».   

4.28.	 Рекомендуется не изменять значений параметра треппинга (Trapping), существующих по 
умолчанию после инсталляции программ. Ответственность за изменение значений треп-
пинга, определенных по умолчанию, либо за некорректную их расстановку в макете несет 
Заказчик. 

4.29.	 При дизайне макета следует учитывать, что текст, наложенный на фон разной красочно-
сти, после треппинга может выглядеть как текст разной толщины.

4.30.	 Если вам важно сохранить в макете неизменными параметры Overprint и Trapping, то со-
общите о данном факте менеджеру типографии. 
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5.  Требования к шрифтам в макетах
В производство принимаются макеты, созданные с использованием оригинальных лицензионных 
шрифтов. В случае использования Заказчиком нелицензионных шрифтов или несоблюдения тре-
бований, изложенных в разделе 5, типография не гарантирует правильное отображение текстов, а 
также не несет ответственности за возможные дефекты и брак в готовой продукции, связанные с 
использованием в макете некорректных шрифтов.

5.1.	 В верстке не должны быть использованы системные шрифты, которые устанавливаются 
при инсталляции операционных систем Windows или Mac OS. 

5.2.	 При использовании расширенных возможностей (features) OpenType шрифтов – капите-
ли, лигатур и т. д., необходимо сообщить об этом и желательно преобразовывать такой 
текст в «кривые», т. к. не все программы корректно обрабатывают подобный текст.

5.3.	 Принимаемые форматы шрифтов для операционной системы Windows
	 Шрифты в формате PostScript Type 1, для каждого начертания шрифта предоставляется 

набор файлов одного из двух видов:
•	 PFB-файл (Print Font Binary) с информацией о контурах,
	 PFM-файл (Print Font Metrics) с информацией о ширине символов и кернинге.
•	 PFB-файл (Print Font Binary) с информацией о контурах,
	 AFM-файл (Adobe Font Metrics) с информацией о ширине символов и кернинге, INF-

файл, содержащий дополнительную информацию, которая требуется для инсталляции 
шрифта.

Шрифты в формате TrueType
•	 отдельный ТТF-файл для каждого начертания шрифта.
Шрифты в формате OpenType
Отдельный файл для каждого начертания шрифта. Файлы могут быть двух типов:
•	 OTF – шрифт на основе PostScript данных;
•	 TTF – шрифт на основе TrueType данных.

5.4.	 Принимаемые форматы шрифтов для операционной системы MacOS X
	 Файлы шрифтов, включая файлы макетов, выполненных в операционной системе  

Mac OS, перед передачей в типографию необходимо сохранить в SIT- или SITX-архиве.
	 Шрифты в формате PostScript Type 1 

•	 предоставляются в виде совокупности файла Suitcase (Font suitcase) с экранными пред-
ставлениями всех начертаний шрифта и файлов принтерных шрифтов для каждого на-
чертания отдельно (PostScript font).

	 Шрифты в форматах TrueType и OpenType
•	 отдельный файл Suitcase для каждого начертания шрифта.

5.5.	 Минимальный размер шрифта зависит от параметров шрифта и особенностей макета.
•	 Для рубленых гарнитур 6 pt (CMYK), 5 pt (монохромный цвет).
•	 Для засеченных гарнитур 7 pt (CMYK), 6 pt (монохромный цвет).
•	 Выворотка для рубленых гарнитур 7 pt (CMYK), 6 pt (монохромный цвет).
•	 Выворотка для засеченных гарнитур 8 pt (CMYK), 7 pt (монохромный цвет).
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6. Требования к файлам для фальцующихся изделий
6.1.	 В файлах обязательно должны присутствовать метки фальцовки в дообрезном формате 

изделия, но не ближе чем в 5 мм от обрезного размера изделия.
6.2.	 При подготовке буклетов верстайте готовыми разворотами и учитывайте, что все заги-

бающиеся внутрь полосы должны быть короче на 2-3 мм. Для типового изделия формата 
А4 (297×210мм) на лицевой несфальцованной стороне буклета расстояния между

	 параллельными фальцами должны быть (Х-3)-Х-Х = 97 мм, 100 мм, 100 мм, т. е. внутрен-
няя сторона изделия на 3 мм короче двух внешних, которые равны между собой.

6.3.	 Для буклетов, фальцующихся гармошкой, размеры полос могут быть любыми. Для изде-
лия формата А4 (297×210) обычно размеры составляют 99 мм, 99 мм, 99 мм.

7. Требования к файлам для многополосных изданий
7.1.	 Для многополосных брошюр, скрепляемых на скобу, при верстке необходимо иметь в 

виду сползание (для изделий объемом более 24 полос), появляющееся в процессе брошю-
ровки и учитываемое на этапе спуска полос на печатный лист. Значимые элементы ди-
зайна, расположенные на полосах близко к корешку или краю обрезного формата, могут 
быть потеряны или недопустимо близко сдвинуты к корешку или к резу в процессе фи-
нальной подрезки сброшюрованного изделия. Величина сползания увеличивается в на-
правлении от наружней тетради к внутренней, достигая к внутреннему развороту своего 
максимального значения. Чем больше полос и чем плотнее бумага, тем больше величина 
сползания.

7.2.	 Для изделий, скрепляемых на пружину, – календарей, блокнотов 
и т. д., следует учесть размер пружины 6 мм + отступ от пружи-
ны 5 мм для значимых элементов дизайна макета.

7.3.	 Для многостраничных изделий на КБС (клеевое бесшвейное 
скрепление).
7.3.1.	Обложка для издания на КБС должна быть выполнена «в 

разворот» с учетом толщины корешка, которая зависит от 
количества полос в издании и толщины тиражной бумаги, 
и уточняется у технолога через менеджера типографии. 

7.3.2.	  Корешок с внутренней стороны обложки и корешки пер-
вой и последней полос блока должны иметь белое поле 
шириной 3 мм (для надежного приклеивания обложки к 
блоку).
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7.3.3.	При дизайне обложки необходимо учесть, что по 6 мм на второй и третьей полосе 
обложки будет приклеено к первой и последней полосе блока и, соответственно, на 
эти 6 мм проклейки уменьшится полезная площадь сюжета.

7.3.4.	Если в издании есть иллюстрации «в разворот» между обложкой и блоком, то не-
обходимо учесть 6 мм проклейки и обеспечить смещение элементов сюжета на по-
лосах для обеспечения стыковки разворотных объектов (иллюстраций и текстов) 
с учетом раскрываемости блока. На рисунке ниже показано, как следует готовить 
иллюстрацию в разворот.

8. Требования к файлам для послепечатной отделки – 
	 высечки, сверления, тиснения, выборочного лакирования и т. д.

8.1.	 О всех объектах послепечатной отделки в файлах нужно сообщить.
8.2.	 К файлам заказа рекомендуется приложить подробное описание точного местоположения 

объектов послепечатной отделки и понятную схему с указанием размеров. 
8.3.	 Наиболее комфортный формат файла для послепечатной отделки – EPS в слоях (layers).
8.4.	 В файлах макета все объекты послепечатной отделки должны быть совмещены с сюже-

том изделия, находиться на отдельном слое в файле, окрашены в 100 % Spot-краску с 
условным названием цвета – cut, big, falz, tisnenie, varnish и т. д. и иметь атрибут Overprint 
On. 

8.5.	 Все объекты для послепечатной отделки должны быть выполнены в векторном виде 
и не должны содержать полутонов, например, 0 % – лака нет и 100 % – лак есть. Вы-
борочный лак, тиснение и конгрев выполняются заливкой (Fill), контур высечки –  
линиями (Stroke). 

8.6.	 В файлах изделий со сверлением и установкой люверсов – на отдельном слое должна при-
сутствовать метка (крест) для указания центра сверления или посадки люверсов.

8.7.	 В файлах изделий со скруглением углов на отдельном слое должен присутствовать штамп 
или приложена подробная схема с указанием размеров радиуса скругления углов.

8.8.	 Контур высечки маркируется следующим образом: вырубные ножи и надсечка – 
сплошные линии, биговальные ножи – пунктирные линии, перфорация и рицовка – 
штрих-пунктир.

8.9.	 Значимые элементы сюжета при высечке должны быть расположены на расстоянии мини-
мум 3 мм от линии ножей штампа высечки, рекомендуется использовать 5 мм.

8.10.	 Рекомендуется устанавливать геометрические размеры объектов послепечатной отделки  
(высечки, тиснения/конгрева и выборочного лакирования и т. д.) – кратным 1 мм.
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8.11.	 Объекты для высечки и тиснения фольгой не должны повторять отпечатанные элементы 
изделия, также рекомендуется не допускать в макете совпадения объектов выборочного 
лака, фальцовки, тиснения/конгрева и т. д.

8.12.	 Технологические допуски на высечку, тиснение и нанесение выборочного лака зависят от 
макета изделия, используемых материалов (тиражной бумаги, фольги и т. д.) и реальных 
возможностей имеющегося парка полиграфического оборудования и могут быть изме-
нены в процессе технологической проверки файлов макета при приеме заказа в произ-
водство. Рекомендуется уточнить технологические допуски на изготовление продукции у 
менеджера типографии и желательно заказать изготовление пробного сигнального экзем-
пляра изделия.
•	 Минимальная толщина линии для тиснения фольгой – 0,2 мм. 
•	 Минимальное расстояние между двумя соседними линиями для тиснения – 0,3 мм.
•	 Минимальная толщина линии для конгревного тиснения – 0,5 мм. 
•	 Точность нанесения выборочного лака составляет ± 0,7 мм, поэтому минимальная тол-

щина объектов лака – 2 мм.
•	 В процессе послепечатной отделки листы печатных оттисков могут смещаться на 1 мм 

и поэтому линии реза, бига, фальца и пр. могут также смещаться на это расстояние.
•	 Точность позиционирования штампа относительно сюжета изделия – 1 мм.

9. Требования к PDF-файлам
9.1.	 Прочтите раздел «Общие требования к макетам».
9.2.	 PDF-файлы должны быть композитными (composite) в формате 1.3 («Acrobat 4 

compatible»). Данная версия PDF не поддерживает использование эффектов прозрачно-
сти (transparence) и смешения цветов (blending mode), поэтому при записи PDF 1.3 все 
эффекты преобразуются в простые объекты.

9.3.	 Не используйте Overprint и эффекты прозрачности в объектах, окрашенных смесевыми 
красками PANTONE, такие объекты могут быть ошибочно воспроизведены в PDF и впо-
следствии некорректно напечатаны. 

9.4.	 В файле не должно быть внедренных ICC-профилей.
9.5.	 В файле не должно быть объектов сертифицирования и комментирования, Flash- и 

Java-скриптов.
9.6.	 Все используемые шрифты должны быть полностью внедрены (embedded) в PDF-файл.
9.7.	 Все иллюстрации должны быть внедрены в PDF-файл без функции OPI.
9.8.	 Обрезной формат изделия в PDF-файле должен быть указан при помощи параметра Trim 

Box или программными обрезными метками (Crop Marks), которые устанавливаются за 
пределами Trim Box, но не ближе чем в 5 мм от Trim Box. Этот отступ задается при созда-
нии PostScript и PDF-файлов из приложения верстки – числовым значением в параметре 
Offset в закладке Marks.

9.9.	 Размер документа в PDF-файле должен быть достаточным, чтобы вместить обрезной 
формат изделия вместе с вылетами за обрез. Позиционирование обрезного формата из-
делия должно быть по центру документа PDF-файла. 

9.10.	 Максимально корректные PDF-файлы получаются при обработке PostScript-файлов про-
граммой Acrobat Distiller. Желательно, чтобы PostScript-файл был получен с использо-
ванием нашего виртуального принтера «HD_MetaDimension». Для генерации PDF из 
PostScript используйте «Printluxe.job-options» – файл настройки для Acrobat Distiller, ин-
формацию об этом можно получить у менеджера типографии.

9.11.	 Желательно, чтобы PDF-файлы соответствовали стандарту PDF/X-1a:2001.
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10. Требования к EPS-файлам
10.1.	 Прочтите раздел «Общие требования к макетам».
10.2.	 Рекомендуется вместо EPS-файлов использовать PDF, это гораздо удобнее и надежнее. 

Все современные программы верстки позволяют экспортировать и импортировать PDF. 
10.3.	 При записи EPS-файла учтите, что размер страницы не сохраняется и конечные габариты 

будут включать все объекты в документе, на странице и вне ее. Оценить габариты можно 
выделив все объекты в документе. Поэтому при записи EPS из Illustrator создайте пря-
моугольник по необходимому размеру иллюстрации и примените его в качестве маски ко 
всему содержимому страницы (все содержимое должно находиться внутри этой маски).

10.4.	 Все шрифты в файле должны быть преобразованы «в кривые» командой «Create Outlines».
10.5.	 В EPS-файлах не должны быть использованы дополнительные каналы и пути, кроме пути 

обтравки – Clipping Path. Если изображение в файле обтравливается, то формат файла 
должен быть только EPS без разделения каналов (без DCS).

10.6.	 При использовании EPS-файлов формата Photoshop DCS 2 сообщите об этом особо. При 
записи EPS-файла DCS 2 из Photoshop выбирайте следующие настройки – Photoshop DCS 
2; Preview: TIFF 8 bit; DCS: Single File with Color Composite; Encoding: Binary. Не исполь-
зуйте параметры Halftone Screen, Transfer Function, PostScript Color Management.  

11. Требования к файлам растровых изображений JPEG, TIFF, PSD
11.1.	 Прочтите раздел «Общие требования к макетам».
11.2.	 Файлы должны быть в одном из цветовых режимов: Bitmap, Grayscale, CMYK, Multichannel, 

Duotone. При использовании режима Duotone сообщите об этом особо.
11.3.	 При использовании JPEG-сжатия учтите, что качество изображения понижается и воз-

можно появление дефектов графического сжатия.
11.4.	 Штриховые изображения должны быть сохранены как Bitmap.
11.5.	 Все неиспользуемые пути-Paths, Spot-каналы и Alpha-каналы необходимо удалить. 
11.6.	 При наличии в изображении слоев с эффектами очень велика вероятность брака в печати. 
11.7.	 Файлы TIFF и PSD должны содержать только один слой – Background (в Photoshop коман-

да «Layer->Flatten Image»).

12. Требования к файлам верстки Adobe InDesign
12.1.	 Прочтите раздел «Общие требования к макетам».
12.2.	 Принимаются версии CS, CS2, CS3, CS4 для Windows и версии CS, CS2 для Mac OS X. 

При подготовке файлов не должны быть задействованы нестандартные модули (plugins), 
отсутствующие в стандартной поставке InDesign. Если дополнительные модули необхо-
димы, то передайте их в типографию или подготовьте из верстки PDF-файл. 

12.3.	 Все изображения, используемые в публикации, должны иметь масштаб 1:1 (100 %). 
12.4.	 Все изображения в верстке должны быть связаны (link) и обновлены (update).
12.5.	 Перед отправкой в типографию обязательно выполните проверку файла верстки коман-

дой «File->Preflight». В отчете вы увидите информацию обо всех используемых шрифтах, 
изображениях и красках. Там же будет информация о возможных проблемах, таких как 
отсутствие необходимых шрифтов или подверстанных (link) файлов. 

12.6.	 Сборку файлов для отправки в типографию выполните командой «File->Package», далее 
в настройках установите все галочки, тем самым включив в сборку все файлы, шрифты и 
необходимые настройки переноса текста.
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13. Требования к файлам Adobe Illustrator
13.1.	 Прочтите раздел «Общие требования к макетам». Принимаются файлы версии CS, CS2, 

CS3, CS4 для Windows и версии CS, CS2 для Mac OS X. 
13.2.	 Количество слоев (layers) не должно превышать разумную цифру, например, 3-5 слоев.
13.3.	 Рекомендуется преобразовать шрифты в векторные объекты «Type->Create Outlines». 
13.4.	 Рекомендуется удалять из файлов пустые элементы «Select Stray points->Delete».
13.5.	 Рекомендуется удалять из файлов неиспользуемые Brushes и Swatches.
13.6.	 Рекомендуется задать в файле настройки растрирования эффектов: 

•	 Effect->Document raster effect settings: CMYK, 150ppi; 
•	 File->Transparency flattener presets: High Resolution.

14. Требования к файлам верстки QuarkXPress
14.1.	 Прочтите раздел «Общие требования к макетам». Принимаются версии 5.х, 6.х, 7.х. 
14.2.	 В верстке не должны быть задействованы нестандартные модули (XTensions), отсутству-

ющие в стандартной поставке QuarkXpress. Если дополнительные модули необходимы 
для работы, то передайте их в типографию или подготовьте PDF-файл.

14.3.	 Все изображения, используемые в верстке, должны иметь масштаб 1:1 (100 %). 
14.4.	 Все изображения в верстке должны быть связаны (link) и обновлены (update).
14.5.	 Не пользуйтесь для обтравки изображений функцией «Non-White Areas» – в разных вер-

сиях QuarkXPress она работает по-разному. Все растровые изображения, кроме сохранен-
ных в формате EPS c обтравкой (Clipping Path), должны быть заверстаны в непрозрачные 
окна. 

14.6.	 При использовании DCS EPS, содержащих Pantone, учтите, что QuarkXPress может выво-
дить файлы формата DCS EPS только в цветоделенном (separated) виде, поэтому пользуй-
тесь современными версиями QuarkXPress 6.52, 7.х и подверстывайте PDF-файлы – это 
обеспечит корректный композитный вывод на печать.

14.7.	 Не используйте для форматирования русского текста кнопки «All Caps», «Small Caps» –  
они могут работать некорректно. При использовании текстовых эффектов «Shadow», 
«Outline» проверяйте параметр «Trapping» – часто он устанавливается неверно. 

14.8.	 Перед отправкой верстки в типографию произведите сборку файлов командой File>Collect 
for Output, в настройках укажите включать в сборку все используемые файлы – шрифты и 
изображения. Возможность проверять файлы верстки появилась в версии QuarkXPress 7, 
предыдущие версии рекомендуется проверять программой Markzware FlightCheck.

15. Требования к файлам CorelDRAW
15.1.	 Прочтите раздел «Общие требования к макетам».
15.2.	 Принимаются версии 9, 10, 11, 12, Х3. Перед отправкой в типографию проверьте доку-

мент командой «File->Document info».
15.3.	 Сборка файлов производится командой «File->Prepare For Service Bureau».
15.4.	 Не задавайте толщину линий как «Hairline» – укажите толщину линий явно.
15.5.	 Все используемые графические эффекты СorelDRAW – Lens, Drop Shadow и т. д. до пере-

дачи файлов макета в типографию растрируйте в СMYK Bitmap 350dpi. 
15.6.	 Не используйте инструмент градиентных заливок, создавайте их в Adobe Photoshop. 
15.7.	 Все шрифты желательно перевести в векторные объекты командой «Convert To Curves».
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16. Требования к цветопробе и образцам цвета
Качество печати должно соответствовать техническим условиям печати, оригинал-макетам и техно-
логическим инструкциям и стандартам. В случае наличия цветопробы цветопередача должна соот-
ветствовать ей в пределах (допусках) установленных стандартов, в случае отсутствия цветопробы 
претензии по цветопередаче не рассматриваются. Цветопробой является оттиск, изготовленный на 
специализированном оборудовании, калиброванном в соответствии с имеющимся печатным процес-
сом. Все распечатки с цветных и лазерных принтеров, а также полиграфические оттиски не являются 
образцами цвета. Все материалы, предоставляемые заказчиком в качестве цветопробы и не соответ-
ствующие ниже приведенным требованиям, не могут служить основанием для предъявления претен-
зий, связанных с отклонениями по воспроизведению цвета. Они могут исполнять только роль пожела-
ния заказчика относительно общей цветопередачи сюжета. 

В качестве образца цвета принимается только ЦВЕТОПРОБА, изготовленная в типографии «Принт-
люкс» в соответствии со стандартом ISO 12647-2. На цветопробе, предназначенной для использования 
в качестве контрактной, должна присутствовать контрольная шкала Ugra/FOGRA Media Wedge CMYK 
V2.0 с размером контрольных полей не менее чем 4×4 мм. Она содержит 33 цветных контрольных 
поля, серый клин, образованный хроматическими красками, серую полутоновую шкалу черного кана-
ла, а также незапечатанное контрольное поле. Шкала Ugra/FOGRA предназначена для оперативного 
контроля качества цифровой цветопробы и используется как электронное средство контроля при ото-
бражении CMYK-данных в процессе допечатной подготовки. Цветные распечатки без подобных шкал 
цветопробами являться не могут.

Цветопроба не может абсолютно точно имитировать печатный процесс. При сравнении печатных от-
тисков с цветопробой всегда нужно учитывать следующие факторы: 

•	 не все оттенки цифровой пробы идентичны печатным оттискам;
•	 цветопроба должна эмулировать цветовое пространство печати на соответствующих типах 

бумаги;
•	 цвет Pantone на печатном оттиске не может соответствовать цвету Pantone в цветопробе, его 

следует сверять с оттенком в веере Pantone соотвествующего типа бумаги и номера;
•	 ни один печатный оттиск не может полностью соответствовать отображению сюжета на мо-

ниторе компьютера в силу используемых особенностей синтеза цвета (аддитивной и суб-
трактивной цветовых моделей) и систем воспроизведения цвета. 

16.1.	 Цветопроба печатается в типографии и утверждается Заказчиком в масштабе строго 1:1.
16.2.	 Цветопроба считается контрактной, если после промера контрольных полей данной шкалы 

CIELAB значения цветов находятся в допустимых пределах:
•	 отклонение ΔE×ab первичных цветов CMYK меньше 5;
•	 среднее отклонение ΔE×ab остальных полей, включая поля баланса по-серому, не более 3,  

а максимальное – не превышает 6;
•	 среднее отклонение ΔE×ab полей, находящихся за пределами шкалы цветового охвата,  

не превышает 4. 


